1099 Data Download

Getting to your 1099-NEC & 1099-MISC data by IRS Box Type
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Overview

What is the web
intelligence tool?

What sources of data
can | access with this
tool for 1099
Reporting?

Use the tool to access
pre-built reports and
create your own

What you’ll be doing
with this tool?

What information you’ll
be pulling from this
1099 Data Extract
template?

The Enterprise Reporting Web Intelligence (ER Webl) tool
provides business users an easy-to-use interactive and
flexible user interface for building and analyzing reports on
state enterprise databases. It provides the querying,
reporting, and analysis all in a single tool.

Using the ER Webl tool and with special security access,
you will be able to access the Agency Financial Reporting
System (The state’s accounting system)’s transactions
data with Tax Identification Number (TIN) information
made available.

You can use the tool to create almost any kind of ad hoc
report.
A 1099 Data Extract template was created for your use.
This template is available in the “AFRS 1099 Report
Template” sub-folder of the Public Folder.
A. Extract Payments data
B. Pull only IRS reportable data for the 1099-NEC &
1099-MISC form
. Create an Excel file by IRS Box Type
Agency
Calendar Year
Payment Transaction Types (B; G; and H)
General Ledger 7120 and 7130
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1099 Data Download
What is it?

1099 Download Application - What is it?

1099 Download Application

The environment that includes the secure 1099 universe,
secure 1099 public folder, and secure 1099 Data Extract (s).

AFRS XXXX with TIN

This is the name of the universe that houses your AFRS
fransaction history with secure access to the tax
identification number (TIN).

The "XXXX" represents the biennium.

AFRS 1099 Report Template

This is the name of the folder in ER Web Intelligence’s public
folder that houses the 1099 Data Exiract templates.

AFRS 1099 Data Extract = XXXX
(Even numbered calendar years)
Example: AFRS 1099 Data Extract
— 2025 includes all of Calendar
Year 2024

AFRS 1099 Data Extract -
Combined CYXXXX (Odd
numbered calendar years)
Example: AFRS 1099 Data Extract
— Combined CY2023 includes all
of Calendar Year 2023

The "AFRS 1099 Data Extract — XXXX" and the “AFRS 1099
Data Extract Combined CYXXXX" are the secure 1099 Data
Extracts. Users can query and filter their AFRS transaction
history details, which includes the secure TIN information.
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How to get to your 1099-NEC & 1099-MISC data

1. Log in to the Bl Launchpad (Webl)

A. Access the following URL: https://reporting.ofm.wa.gov (inside SGN) or
https://secureaccess.wa.gov (outside SGN]).
B. Log in to Bl Launchpad (Webl)

Log in to Bl Launch Pad

E |user Name

Password

Forgot password, User name, or Enable your account

2. Locate the 'AFRS 1099 Report Template’ folder

A. Click on the ‘Folders’ module, located in the upper left corner.

Bl Launch Pad v«

Home  Favorites  Recent Documents  Recently Run  Applic

Folders Categories Documents
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https://reporting.ofm.wa.gov/
https://secureaccess.wa.gov/

B. Click on the arrow next fo the ‘Public Folders’ to expand the list of folders available in the
Webl Public Folders.

Folders

> [23] Personal Folders

[*=] My Subscribed Alerts

[*=] Public Folders
Expand Node

C. Navigate to the ‘AFRS 1099 Report Template’ folder and click on the folder’s title to open
the folder to access the 1099 Data Extract templates.

Folders
> [Z] AFRS 1099 Report Template - Web Intelligence
3. Copy the ‘AFRS 1099 Data Extract’ report into your “Personal
Folders”

Inside the “AFRS 1099 Report Template” public folder there are the AFRS 1099 Data Extract
templates.

A. Right-click on the Report Title for the appropriate calendar year you are reporting on:
1. AFRS 1099 Data Extract - XXXX (Even numbered calendar years)
Example: AFRS 1099 Data Extract — 2025 includes all of Calendar Year 2024
2. AFRS 1099 Data Extract - Combined CYXXXX (Odd numbered calendar years)
Example: AFRS 1099 Data Extract - Combined CY2023 includes all of Calendar
Year 2023
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B. Hover over Organize
C. Select Copy

4o AFRS 1099 Date View Veb Intelligence
4 AFRS 1099 Daté Properties Veb Intelligence
L AFRS 1099 Datz Copy Opendoc Link Veb Intelligence
,» AFRS 1099 Daté Schedule Veb Intelligence
s AFRS 1099 Datz Mobile Properties Veb Intelligence
s AFRS 1099 Date History Neb Intelligence
. AFRS 1099 Dat; Categories Neb Intelligence
AFRS 1099 Datz Mark As Favorite .

* . | Copy
8l AERS 1099 Datz Details e
) Copy Shortcut
v| [, AFRS 1099 Date Organize i

D. Navigate and click on your Personal Folders
< o @

Folders

[v=1

Ay Criiherrihad Alarte

E. Click on the ellipsis in the upper-right corner
F. Select Organize
G. Select Paste

000

Paste _
La St U o @ |

By saving the 1099 Data Extract info your “Personal Folders”, you are making a copy and
become the owner of the template, and this enables your ability to edit.
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4. Modify the 1099 Data Extract template

A. While in your ‘Personal Folders, locate the saved 1099 Data Extract template and right-
click on the report title.
B. Select Modify

Title = Favorites
v AFRS 1099 Data Ext _ .
» View
e ] Properties
> ! Copy Opendoc Link
e Modify

O

[ IR PR R

C. Click 'Enter value(s) for Agency’ and select Agency

3 Prompts Z‘
Search Q Mo C Enter value(s) for Agency: » @
[i] Enter value(s) for Agency: Search or enter value(s) manually
Please select at least one value _
Agency =
[i] Enter value(s) for Calendar Year:
0o1
Please select at least one value
. 005
+/ Enter value(s) for Transaction Type: (3)
BGH "1 o010
+/ Enter value(s) for GL Account: (2) 011
7120; 7130 :
D. Click ‘Enter value(s) for Calendar year’' and select Calendar Year
= Prompts 5
Search Q Mo Enter value(s) for Calendar Year: ®» &
Enter value(s) for Agency: Search or enter value(s) manually

Please select at least one value

Calendar Year

[i] Enter value(s) for Calendar Year:

Please select at least one value 2019
v/ Enter value(s) for Transaction Type: (3 2020
B.G.H 2021
+/ Enter value(s) for GL Account: (2) BC
7120; 7130 :
E. Click Run
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Optional prompits:

Enter Transaction Type (optional) -You do not need to change it if you are satisfied with
the values selected. The values currently selected are:

B - Payments

G - Warrant cancellations

H - SOL warrant cancellations

Enter General Ledger (optional) — You do not need to change it if you are satisfied with
the values selected. The values currently selected are:

7120 - Cash payments

7130 — Warrant cancellations

. Create a new report to pull 1099 data

The 1099 Data Extract template will populate an “Agency AFRS Transaction Detail” Report.
This report has all the transactions that made up the payments. Use this default report to
reconcile the payment transactions. All details included in the default report are not needed
for 1099 reporting.

To create a new report to pull only 1099 reporting datg, review the actual 1099-NEC & 1099-
MISC forms for the requirements.

At a minimum, we need the following data for both the 1099-NEC & 1099-MISC forms:

1)

IRS Box — not needed for the actual 1099 forms. However, the IRS Box information will be
used to determine where to map the amount from AFRS to the IRS Boxes on the 1099
formes.

2) Taxpayer D

3) TaxType

4) Vendor Name

5) Vendor Address 1
6) Vendor Address 2
7) Vendor Address 3
8) Vendor City

9) Vendor State

10) Vendor Zip

11) Amount
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While in Design mode (toggle button in upper-right)
2 Design |
(I S Q'S

Click the down arrow for more report actions next to the ‘Agency AFRS Transaction Detail’
report tab and select New.

Agency AFRS Transaction D...

+ New o

N
Fansaction Code _ Fiscal wortn _mastfLITAE

® Hide

Rename...

Copy Link of the Report

. Click the down arrow for more report actions next fo ‘Report 2’ and select Rename.

Agency AFRS Transaction D... v~ Report 2

+

New
Duplicate
Delete

& Hide

Rename...
d

In the ‘Report Name' text box of the Rename dialogue, enter the new name of ‘1099
Reporting Data’ (or any name meaningful to you), and click OK.

Rename Report

Report Name

1099 Reporting Datd|

OK Cancel
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E. From the main panel list on the right, press and hold the 'Cirl’ key and select each of the
following 1099 data elements in the exact order listed below:
1) IRS Box
2) Taxpayer ID
3) TaxType
4) Vendor Name
5) Vendor Address 1
6) Vendor Address 2
7) Vendor Address 3
8) Vendor City
9) Vendor State
10) Vendor Zip
11) Amount

F. Once the eleven 1099 data elements (in the exact order listed above) are selected, drag
and drop them info the report section in the ‘1099 Reporting Data’ tab.

Analyze Display Navigate
v oo & B B e 1 of 1 2, ﬁ Design | ~
+ @ T N Show main panel
= b v g
Do not drop into the Header % Project
% Reference Doc Num
<% Subagency
IRS Box Taxpayer id Tax Type Vendor Namk Vendor Addri Vendor Addrn Vendor Addn Vendor City  Vendor State Vendor Zip  Amount _ Subobject
: 4 Subsubobject
=% Tax Type
After dropping the data elements, you will see the column Titles = T
< Transaction Code
Select the 11 = Transaction Type
data elements e ! (Bl
a nd Drop % Vendor Address 1
i % Vendor Address 2
% Vendor Address 3
=% Vendor City
< Vendor Name
% Vendor Num

S < Vandnr Kiim Suffiv

You should have 11 columns in the ‘1099 Reporting Data’ tab. Please make sure that the
columns align next to each other in a single table.

G. Click the down arrow for more report actions next to ‘Agency AFRS Transaction Detail’ and
select Delete.

lﬁgency AFRS Transaction D... | ~

+ New

Duplicate

)

I

Delete .
A

& Hide
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6. Filter Data by IRS box type

The dataset will include data for all IRS Box types, including those that your agency has
coded as zero or blank. Transactions with IRS Box type zero or blank are non-1099 reportable.

Filter the data by IRS box type for the following reasons:

e To pull only the data that have reportable 1099 box values
e To export and create one Excel file for each IRS Box Value

o

The purpose of creating one Excel file for each reportable IRS box type is to
help identify which IRS box to map the amount to on the 1099 form. For
example, if you are working with the IRS box 1 file, all amounts in this file would

be mapped to the Rent field on the 1099-MISC form.

Effective IRS reporting year 2020, all non-employee compensation payments, previously
reported in Box 7 of the 1099-Miscellaneous Income (1099-MISC) form, must now be reported
on the 1099-Non-employee Compensation (1099-NEC) form. Get familiar with the IRS box
value from AFRS (data source) with the description of the box on the 1099 forms using the
crosswalk below:

IRS Box Value in

IRS Box Value on

AFRS/ER Webl Description 1099-NEC Form Description
0 or Blank NON-IRS REPORTABLE n/a n/a
NON-EMPLOYEE
COMPENSATION **Previously
NON-EMPLOYEE reported in Box 7 on 1099-MISC
7 COMPENSATION 1 form
FEDERAL INCOME TAX FEDERAL INCOME TAX
4 WITHHELD 4 WITHHELD
IRS Box Value in IRS Box Value on
AFRS/ER Webl Description 1099-MISC Form Description
0 or Blank NON-IRS REPORTABLE n/a n/a
1 RENTS RENTS
2 ROYALTIES ROYALTIES
3 OTHER INCOME OTHER INCOME
FEDERAL INCOME TAX FEDERAL INCOME TAX
4 WITHHELD 4 WITHHELD
FISHING BOAT
5 PROCEEDS 5 FISHING BOAT PROCEEDS
MEDICAL AND HEALTH MEDICAL AND HEALTH CARE
6 CARE PAYMENTS 6 PAYMENTS
CROP INSURANCE
A PROCEEDS 9 CROP INSURANCE PROCEEDS
GROSS PROCEEDS GROSS PROCEEDS PAID TO
C PAID TO AN ATTORNEY 10 AN ATTORNEY
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A. Tofilter data by IRS box, click the data portion of the ‘IRS Box’ column to highlight it.
Right Click and select ‘Data’
C. Select 'Add Filter’

IRS Bo Set as Section Vendor Name Vend

@

Insert > |V Add Filter@
P = Dmmpc'tp .....
Hyperlink > T, Add Sort
Element Link > Remove Sort |
Footer Calculation > %2 Add Rank [
-/~ Assign Reference... Remove R:
[\ Formatting Rules... 74 Add Break

* Data > Remove Break !

D. Inthe pop-up window, select the IRS Box value you are filtering for.

Select values for IRS Box {c}

Search or manual entry Q

o]

v 1

7

[NULL_VALUE]

2y

OK | Cancel

For example, click on the box to select the IRS box value 1 for Rents, then click “OK”.
The report is then filtered by IRS Box “1".

IRS Box
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7. Save the file in Bl Launchpad (Webl) by IRS Box value

A. From the “File” tab, click the down arrow for more report actions next to the Save icon
and select Save As

File Qu
6 «| @
&) save Ctrl+S

Save As
Ny

B. Navigate to “My Folders”

C. Name the file fo include the IRS Box value
For example: YourAgencyCode_YourName_1099_IRSBox_1. Using the IRS box value in the
name will help you identify where to map the amounts in that file. For example, IRS box 1
belongs to the “Rents” box on the 1099-MISC form.

File Name: | YourAgencyCode_YourName_1099_IRSBox_1

Save Cancel

D. Click Save.

8. Export your report to Excel

A. Click on the ellipsis in the ‘File’ tab
B. Select Export

< B

File Query

o B:=:c. -
L Export... T

hb
_— = Print... MMP

1 Cand ta 21 lnkhAwv

Page 13
OFM Training: IRS 1099 Reporting October 2023



C. Ensure Excel is selected on the left side and click Export at the boftom.

Export to 0

@ Excel Excel
Q" PDF Content Options
(4 HTML

®) Reports Data
T

Search Q
(B8 csv

| All reports

V| YourAgencyCode_YourName_1099_IRSBox_1 (Current Report)

Export  Cancel

¥
D. The file will be downloaded. When it's completed, choose Openfile,
Downloads B Q - £ :
& YourAgencyCode_YourName_1099_IRSBox_1 (1).xlsx
- | Open file
E. Navigate to your C: Drive
F. Make a note of the Location of where you've saved the file and the file name.
G. Click Save
Saving to your C: Drive is important when uploading this file to Account Ability.
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9. Repeat

Repeat for the rest of the other IRS box types. It is recommended that you create at least one
payment file for each IRS box value.

You will need more files if your agency has a customized template that is pulling data at a lower
level (for example, by ‘process date’).

A. Remove existing filter
e Highlight the ‘IRS Box’ data by clicking in the data portion of the ‘IRS Box' column.

e Right Click and select ‘Data’
¢ Select ‘Remove Filter’

IRS Box Hide @l Vendor Name Vendor A
1

X Delete Del
&) comments

Set as Section

Insert > % Edit filter

‘ Remove Filter |
Hyperlink > T Add sort
Element Link
Footer Calculaton > €7 Add Rank

o/7 Assign Reference...
[\ Formatting Rules... /4 Add Break

X Data >

B. Repeat steps to
C. Filter Data by IRS box Type

D. Repeat steps to Save the file in Bl Launchpad (Webl) by IRS Box value

10. Logout

A. Please click on ‘Log Off’ Enterprise Reporting (ER) Web Intelligence (Webl) to release a
Webl license.
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Qa w0 @ @
{:@} Settings ‘

// Edit Home Page

[ —
i & @ Helbp I
Dimensions () apout

% Accol :

% il (") Logout &
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Creating your Tab-delimited 1099 source file, by IRS Box

1. Navigate to the location where you have saved the exported file (s) from Enterprise
Reporting Web Intelligence (ER Webl).

2. Open one of the Excel spreadsheets you've downloaded from ER Webl
Note: You will repeat steps for each Excel spreadsheet (each IRS Box file).

1) Review your data
2) Delete column A and row 1 (only if blank)
A. Taxpayer Identification Number (TIN) — Please review your TIN information for the
following:
» Cannoft be blank
» Must be 9 characters
» Atleast one address must be available
» Check for valid zip codes
B. Review Amount — negative amounts represent the payments.

Note: Delete the ‘Agency AFRS Transaction Details’ report, if not already done so during the
ER Webl download process.

3. Create Text Tab delimited text file
A. From the new report, select ‘File and ‘Save As’
B. Save As 'Text (Tab delimited)’ format

Please note: Steps may be different due to
different version of Microsoft Office used.

C. Browse to your location of where you would like to save your text tab delimited
file

D. Inthe ‘File Name' section of the “Save As” dialogue, tifle your file

E. Inthe 'Save as type’ list, select ‘Text (Tab delimited) (*.txt)’

WOrk
25

File name: 1099_Template_1630_IRSBox_1_Rentsxls

| i
Save as type! || Fyee| 97-2003 Workbook (*,xs)

Excel Template {* xlkx)

F. Click ‘Save’ to save your selection.
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G. Saving the selection — Click ‘Yes’ to “*Do you want to keep using that formate”

r

1 - B
Microsoft Excel S

Some features in your workbook might be lost if you save it as Text [Tab delimited).

Do you want to keep using that format”

P I Yes I ’ Mo ] [ Help ]

o

M = ; e
PO BOX AE m MOSES LAK WA 98337

H. Click ‘Close’ to close the Excel spreadsheet.

I. Save - Click ‘Save’ to “Want to save your changes to...”

- Ol YRIPLS WA . q

. s r

N Microsoft Excel g
r

1 Want to save your changes to rg

R . '0_IR5_1099 Training.bd'? v
r

[ Save ] [ Don't Save ] [ Cancel g

r

L : A g

r

_AKE BLVD SWY dr I TUMWATER WA g
L

J. Click ‘Yes’ to “Microsoft Excel - Some features in your workbook might be lost if
you save it as Text (tab delimited) — Do you want to keep using that formate”

Micrasoft Excel S

Some features in your workbook might be lost if you save it as Text [Tab delimited).

Do you want to keep using that format?
m [ Yes _] [ No ] [ Help
20, -
20 BOX AE @ MOSES LAK WA '9883?
ARLINGTOMWA I'98223

4. Repeat steps for each Excel spreadsheet (each IRS Box).
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